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1. General Summary 
 
Roots constitute a large proportion of terrestrial net primary productivity(~33%, Jackson et al. 1997), 
fluxes of carbon and other nutrients into soil via roots often equal or exceed fluxes from above-ground 
litter (e.g. Roderstein et al. 2005). Roots also play a key ecological role supplying plants with water and 
nutrients. Therefore, to understand terrestrial ecosystem biogeochemistry and ecology it is necessary to 
record information about spatial and temporal patterns of root growth.  

This manual presents some methods which are suitable for quantifying these patterns given the 
restrictions which are often present for fieldwork in tropical forests (e.g. remote field sites, unpredictable 
electricity supply, and lack of specially trained field assistants). For a wider review of techniques see Vogt 
et al. (2000) and Hendricks et al. (2006). These techniques are designed to address the following broad 
science questions: 

1) How much root material per unit area is produced over time? 
2) What factors control root production? 
3) What effects does root production have upon other ecosystem processes (e.g.: soil respiration)? 

 
2. Methods summary & key references 
 
Rhizotrons are chambers inserted into the soil, which allow frequent in situ observation of root growth 
(Bernier & Robitaille 2004, Davis et al. 2004, Sword et al. 1996, Tingey et al. 2000, West et al. 2003). 
The chambers consist of a transparent perspex sheet which is supported by a wooden framework. The 
length extension of roots growing adjacent to the perspex sheet can be recorded as an indicator of root 
growth. 

Ingrowth cores are cores of root free soil surrounded by mesh bags, which allow estimation of root 
production per unit area per unit time. (for more details see general reviews, above). Their key 
disadvantages compared to rhizotrons are that they involve substantial and continual disturbance of the soil 
and roots (Lukac & Godbold 2001, Steingrobe et al. 2001), and that measurements are relatively 
infrequent. Their principal advantages are that they provide measurements in units which are directly 
comparable with most other carbon stocks and fluxes (biomass/ground area), and that relatively simple 
supplementary measurements allow advanced analysis of soil CO2 respiration.  
 
3. Methods 
 
3.1. Rhizotrons (see datasheet) 
 
3.1.1 Construction 
See Rhizotron construction plan in the Appendix. 
 
3.1.2. Installation (see images 1 & 2 in the Appendix) 
Ideally, installation should take place in the dry season otherwise high rainfall can erode the contact 
between the perspex and soil. Excavate a square hole in the soil (width~0.5m, length~0.5m, depth~0.5).  
Save some of the soil that is excavated in a plastic bag, if there are distinct horizons in the soil save soil 
from each horizon in different bags. Roughly insert the chamber to test that the hole is approximately the 
right size. Cut one soil face so that it is as flat as possible. Insert the chamber ensuring that the perspex face 
is as close to the flattened soil face as possible. Use a hammer to secure the ‘feet’ of the rhizotron in the 
soil at the bottom of the hole. Make sure that the top edge of the perspex sheet remains level with the soil 
surface. Using the soil in the plastic bags, fill in the space between the perspex and soil face. If there is soil 
in bags from different horizons, fill in soil to replicate the level of horizons present in the undisturbed soil. 
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Use a rod to compact the soil to replicate density of undisturbed soil. Place the foam insulation next to the 
inside face of the rhizotron, and the plastic cover over the chamber.  

Important: Wherever possible avoid disturbance of the soil-perspex interface; avoid compaction by 
roping off 1m2 around the rhizotron, orientate the plastic rhizotron cover in a way that does not divert 
water onto the perspex-soil interface, ensure that the interface has leaf litter spread over it (see image 1 in 
the Appendix). 
 
3.1.3. Data collection 
Root length is recorded by placing a transparent A4 sheet over the perspex face of the rhizotron and tracing 
visible roots using a fine permanent marker (see image 3 in the Appendix). Each transparency should be 
marked with an identity code (plot, rhizotron number e.g.: PA_R1), and bars along the long edge to mark 
10 and 20cm from the soil surface. Each root is divided into segments marked by crossbars. The segments 
correspond to the incremental increases in root length observed each recording session. Beside each traced 
root segment is noted the number of the recording session that the segment appeared, and the number of 
the session that the segment disappeared. Root diameter is indicated by colour (>1mm = black, 1-2mm = 
blue, 2-3mm = red, <4mm = green). Note that the majority of tracing will occur on session 1; after this 
only appearance of new roots, and growth of existing roots needs to be traced. Soil moisture and 
temperature should be recorded every session at the same point within 0.5m of the rhizotron, but not near 
the perspex-soil interface. The date of each session, along with soil temperature and moisture, is recorded 
in a datasheet (see Rhizotron datasheet in Datasheets).  

Important: if possible allow only one person to trace the roots, to avoid apparent changes in root 
growth due to changes between personnel.  
 
3.1.4. Data processing 
Transparencies should be scanned (colour scan, jpeg, 150 dpi). It is not essential to scan the transparencies 
every session since the history of growth from all sessions is recorded in the transparencies themselves. 
The scanned images are then analyzed with commercial available software (WinRHIZO Tron, Regent 
Instruments, Canada). The software allows length measurement of traced roots, and attachment of relevant 
root and segment information (session appearance and disappearance, and root diameter). For further 
details see the Regent Instruments website (http://www.regent.qc.ca/) or contact Daniel Metcalfe 
(d.b.metcalfe@sms.ed.ac.uk). 
 
3.1.5. Data calibration 
3.1.5.1 Recorder accuracy To test the reliability of the tracing method, it is necessary to record the 1) error 
of length estimates from the same data collector, 2) error of length estimates between different trained 
collectors. Ask the principal root tracer to trace root length 5 times each from 4 rhizotrons (a total of 4 × 5 
= 20 transparencies). For the same 4 rhizotrons, ask 4 other assistants to make tracings ((4 + 1) × 4 = 20). 
Ensure that the assistants have been properly instructed by the principal root tracer about the method and 
the level of detail which is required. Use the 5 measurements per rhizotron from the same collector to 
calculate within-collector average variance and standard deviation. Use the 5 measurements per rhizotron 
from the 4 different collectors to calculate between-collector average variance and standard deviation. 
3.1.5.2. Length-mass conversion It is useful to convert rhizotron length measurements into units of tonnes 
per hectare for comparison with other ecosystem carbon stocks and fluxes. There are a number of indirect 
conversion methods (Bernier & Robitaille 2004, see references in Tingey et al. 2000). We present here a 
direct conversion method.  

Install 20 rhizotrons, allow 3 months for roots to grow into contact with the perspex, then trace 
roots from all rhizotrons using the method detailed above. Immediately after tracing, remove every 
rhizotron being careful not to disturb the soil face adjacent to the perspex. Mark the A4 (width = 21cm 
,depth = 30cm) area of the soil which corresponds to the area traced onto the transparency. Insert drawing 
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pins of a known length around the perimeter and within the marked soil area. Place a plastic tray at the 
bottom of the hole, below the marked soil face. Use a wide chisel type implement (e.g. chisel!!, plastering 
spatula, flat-edged spade) to carefully remove the surface layer of soil from the marked area, using the pins 
as a guide. The removed layer of soil should be collected in the plastic tray at the bottom of the hole, and 
then transferred to a labelled plastic bag (i.e.: sample number). To retrieve the roots from the collected soil, 
first wet sieve (mesh diameter~1mm) the soil and then place material which does not pass through the 
sieve in a drying oven. Remove the dried material and manually separate the roots. Root samples can then 
be dried and weighed. 

We now have 20 root length values from separate rhizotrons, and 20 corresponding root mass 
values. There should be a linear relationship between root length and mass- plot the values on a scatter 
graph to check, and display the equation for the line. This equation can now be used to calculate root mass 
where only length is known (i.e.: all the other rhizotrons which are installed permanently to record root 
growth). The thickness of the soil slice taken from each rhizotron is also known (thickness = length of the 
drawing pins). So we now have mass per unit ground area, all that remains is to convert grams into tonnes, 
and scale up the ground area of the soil slice to a hectare. 
 
3.2. Ingrowth cores (see datasheet) 
 
3.2.1. Installation & removal 
Remove cores of soil (diameter~14cm, depth~30cm) with a post-hole digger (Portuguese=draga). Place 
each core in a labelled plastic bag (plot, core number e.g.:PA_IGC1). Clean the soil of roots with a coarse 
sieve (diameter~0.5cm) and by hand. The roots collected can be dried, weighed and used to estimate 
standing crop root mass (see next section, below). Insert cylindrical mesh bags into the holes, and reinsert 
the root-free soil back into the holes from which they came. After an interval of approximately 3 months 
extract the mesh bags (but carry out supplementary measurements before, see below), and place the soil 
cores in labelled plastic bags.  

Important: place some leaf litter onto the surface of the core once it has been reinstalled, to mimic 
field conditions. 
 
3.2.2. Supplementary measurements 
Measure soil respiration directly above the ingrowth cores with an IRGA system (e.g.: EGM-4 and SRC-1 
IRGA, PP Systems, see image 4 in the Appendix). For more information consult the PP systems website 
(http://www.ppsystems.com/EGM.html), or the basic operational guidelines in the Appendix. You will 
need to insert a cylindrical collar first (before measurement record collar height above the soil). Remove 
leaf litter from within the collar and place in a labelled plastic bag (plot, core number e.g.: PA_IGC1), then 
measure respiration again. Now record soil moisture using a TDR probe and temperature. 

Place litter samples in labelled paper bags (plot, core number PA_IGC1) and put them in a drying 
oven. Once dry, remove residual mineral soil from the litter samples over a fine sieve (~0.2mm diameter) 
and weigh. Two mass measurements should be made: fine litter- excluding undecomposed fruit or twigs 
over 0.5cm diameter, and total litter. 
 
3.2.3. Extracting roots from cores 
Remove roots by hand for a period of 40 minutes per sample but split the sampling period into 10 minute 
time-steps. Place sub samples of roots collected from each time step into separate labelled plastic bags 
(plot, sample number, time step PA_S1_0-10). Place sub samples which all belong to the same sample into 
a single labelled plastic bag (plot, sample PA_IGC1). Important: whilst processing each sample try to keep 
sampling effort constant. For example, do not change the number of personnel halfway through processing 
a sample. Differences in sampling effort between samples are no problem, differences within samples 
should be minimised.  
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The purpose of sampling by hand instead of using sieves is to avoid excessive alteration of soil 
texture. Splitting the sampling period into time steps potentially allows estimation of the amount of root 
material remaining uncollected in the soil sample after 40 minutes (for a detailed explanation contact 
d.b.metcalfe@sms.ed.ac.uk). 
 
3.2.4. Processing root samples 
Clean root sub samples of residual dirt and detritus, and scan them. They should be scanned as greyscale at 
600 dpi resolution and saved as individually identifiable tiff image files (plot, sample, time step 
PA_S1_10-20). It is a good idea to place transparencies above and below the samples in the scanner, this 
avoids getting much dirt on the scanner itself and makes it much quicker to retrieve all of the roots once 
they have been scanned. Before scanning try to arrange the roots on the scanner so that they overlap each 
other as little as possible. After scanning place each sub sample into a labelled paper bag and put in a 
drying oven. Once dry, remove residual mineral soil from the root samples and weigh. Important: the 
interval between removing roots from the soil and scanning them should be as short as possible (>48 
hours). 
 Analyze scanned images of roots with commercially available software (WinRHIZO, Regent 
Instruments, Canada, not to be confused with different software- WinRHIZO Tron- made by the same 
company!). The software allows measurement of root length and surface area (Bouma et al. 2000). 
Depending upon the type of image and scanner, software settings have to be altered to achieve an accurate 
result. For further details see the Regent Instrument website (http://www.regent.qc.ca/) or contact Daniel 
Metcalfe (d.b.metcalfe@sms.ed.ac.uk).  
 
3.2.5. Data calibration 
3.2.5.1. WinRHIZO accuracy It is necessary to test the reliability of root length and surface area values 
provided by WinRHIZO. To do this cut up fine electrical wire of three different diameters (e.g.: 0.5mm, 
1mm , 2mm) into 5 cm segments. Arrange and scan the segments following the same protocol and scanner 
settings as described above. Take as many scans as possible (minimum~10) with a wide range of total 
lengths and various combinations of segments with different diameters. 

Important: for each scan note the actual total wire length, and length of wire of each diameter 
category. Plot root length and surface area calculated by WinRHIZO against actual root length and surface 
area. If it is reliable there should be a close 1:1 relationship. If not, check if there are some problems with 
the software settings. Use the difference between these multiple paired values to calculate mean and 
standard deviation of the error. 
 
3.3. Standing crop soil cores (see datasheet) 
 
3.3.1. Core extraction 
Do not remove soil cores until the last moment, since it is desirable to have as small an interval between 
core removal and root respiration measurements (see below) as possible. Carry out the supplementary 
measurements first. Remove soil cores (diameter~14cm, depth~30cm) with a post-hole digger 
(Portuguese=draga). Place each core in a labelled plastic bag (plot, core number e.g.:PA_SCC1). Record 
the time of extraction for every core, and measure the exact diameter and depth of the hole. 
 
3.3.2 Supplementary measurements 
Measure soil respiration, directly above the location where the soil core will be extracted, with an  IRGA 
system (e.g.: PP systems EGM-4 and SRC-1). You will need to insert a cylindrical collar first (before 
measurement record collar height above the soil). Remove leaf litter from within the collar and place in a 
labelled plastic bag (plot, core number e.g.: PA_SCC1), then measure respiration again. Now record soil 
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moisture (using a TDR probe) and temperature. Place litter samples in labelled paper bags (plot, core 
number PA_IGC1) and put them in a drying oven.  

Once dry, remove residual mineral soil from the litter samples over a fine sieve (~0.2mm diameter) 
and weigh. Two mass measurements should be made: fine litter- excluding undecomposed fruit or twigs 
over 0.5cm diameter, and total litter. 
 
3.3.3. Extracting roots from cores 
Remove roots by hand for a period of 40 minutes per sample but split the sampling period into 10 minute 
time-steps. Set aside root sub samples collected in the first time step (0-10 minutes)- these will be used to 
measure root respiration (see processing root samples section, below). Place sub samples of roots collected 
from each time step into separate labelled paper bags (plot, sample number, time step PA_S1_0-10) then 
put them in a drying oven. Important: whilst processing each sample try to keep sampling effort constant. 
For example, do not change the number of personnel halfway through processing a sample. Differences in 
sampling effort between samples are less of a problem, differences within samples should be minimised.  

The purpose of splitting the sampling period into time steps is to allow estimation of the amount of 
root material remaining uncollected in the soil sample after 40 minutes (see detailed explanation at the end 
of this subsection). 
 
3.3.4. Processing root samples 
Make a sealed chamber (use a collar from the EGM-4 and close one end with plastic and tape) Place each 
root sub sample collected during the first time step into the chamber and measure respiration using the 
EGM-4 and SRC-1 system (i.e.: by connecting the SRC-1 chamber to the modified collar containing the 
root material). Do this as soon as possible- the interval between core extraction and root respiration 
measurement should be as short as possible. Note the time of measurement for each sub sample and the 
respiration value. 

Once the samples are dry, remove residual mineral soil from the roots and weigh. Two mass 
measurements should be made: fine roots- excluding roots over 0.5 cm diameter, and total roots. 
 
3.4. Data analysis 
 
3.4.1. Useful equations 
3.4.1.1. TDR frequency conversion  
VMC = (- 0.0663 - ((1 / (Ftdr × 1000) × 1000000) × 0.0063) + (0.0007 × ((1 / (Ftdr × 1000) × 1000000) ^ 
2))) × 100 
VMC = volumetric moisture content (%) 
Ftdr = TDR probe frequency output (Khz) 
3.4.1.2. Respiration unit conversion  
R2 = R1 × 6.312 
R2 = soil respiration (umol/mol/m2/s) 
R1 = soil respiration/EGM-4 output (g/m2/hr) 
3.4.1.3. Respiration chamber volume correction  
Rc = Ruc × (((Axsc / Vc) × ((Axsc × (Hc / 100)) + Vc)) / Axsc) 
Rc = corrected soil respiration (g CO2 /m2/hr) 
Ruc = uncorrected soil respiration (g CO2/m2/hr) 
Axsc = cross-sectional area of the respiration collar (m2) 
Vc = chamber volume (m3) 
Hc = collar height (cm) 
 
3.4.2. Rhizotron data 
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The raw data derived from analysis of rhizotron images with WinRHIZO Tron is cumulative root length 
over time. Simple data manipulations which may yield interesting results include calculating root length 
grown at each time interval between sessions, and root length grown as a percentage of what already 
existed (this controls for existing differences in the amount of root length present). Root growth between 
sessions may be related to other measured variables (e.g.: soil moisture, root diameter, above-ground 
growth). Root appearance and disappearance date can be used to calculate average root longevity, survival 
curves of roots and to estimate the influence of different factors upon root mortality (e.g.: soil moisture, 
root diameter). For more information about Survival Analysis consult a good statistics book, the help 
section of most statistical software packages, or Daniel Metcalfe (d.b.metcalfe@sms.ed.ac.uk). The depth 
distribution of root length, and root dynamics at different depths may be estimated using the bars on each 
transparency marking 0-10cm. 10-20 and 20-30 cm depth from the soil surface. 
 
3.4.3. Root data from soil cores 
Ingrowth cores provide estimates of root mass, length and surface area production for different periods 
during the year, in the uppermost 30cm of soil. It is then possible to calculate other useful parameters such 
as root length and surface area per unit mass. These values may be compared to above-ground estimates of 
wood, foliage mass production and Leaf Area Index. Standing crop cores provide estimates of standing 
crop root mass, again in the uppermost 30cm of soil. This can be compared with stocks of carbon in the 
soil, coarse woody debris, live stem wood and foliage. Annual root mass production (from ingrowth cores) 
divided by root standing crop mass also gives an indication of annual root turnover. 
 
3.4.4. Supplementary data from soil cores 
The two measurements of soil respiration (with and without litter) per core should be corrected to account 
for the increase in chamber volume due to the collar attachment (see Useful Equations, above). Using the 
supplementary data it is possible to estimate leaf litter and root respiration with the following equations: 
Rl = (((Rs – Rwl) / Mlf ) / (1 / Axsc))  
Rr = (((Rr0-10 / Mr0-10) × Mr) / (1 / Axsc)) 
Rl = litter respiration (g C02/g litter/hr) 
Rr = root respiration (g CO2/g roots/hr) 
Rs = soil respiration with litter (g/m2hr). 
Rwl = soil respiration without leaf litter (g/m2/hr). 
Mlf = fine leaf litter dry mass (g). 
Axsc = cross-sectional area of the respiration collar (m2). 
Rr0-10 = respiration of standing crop roots collected during the first time step (g/m2/hr). 
Mr0-10 = dry mass of standing crop roots collected during the first time step (g).  
Mr = total dry mass of standing crop roots (g). 

An alternative, less invasive method of estimating litter and root respiration is to plot total and/or 
fine litter/root mass against total soil respiration. If the relationship is linear, the y-intercept will represent 
an estimate of soil respiration at litter/root mass = 0. The change in respiration caused by litter/root mass 
can be calculated from the slope.  

SOM respiration per unit mass cannot be calculated here. To present litter, root and SOM together 
it is necessary to calculate respiration per unit ground surface area (g CO2/m2/hr) per core with the 
following equations: 
Rl:  (Rs – Rwl) 
Rr: (Rr0-10 / Mr0-10) × Mr 
Rsom: Rs – (Rwl + Rr) 
Rl = leaf litter respiration (g CO2/m2/hr). 
Rr = root respiration (g CO2/m2/hr). 
Rsom = SOM respiration (g CO2/m2/hr). 
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Note that with this unit it is not possible to distinguish between variation in respiration caused by 
differences in component mass, and variation caused by differences in respiration per unit mass. Estimates 
of root respiration using this method are likely to be an underestimate because the take account only of root 
mass in the uppermost 30cm of soil. 

One potential problem with the direct method we use to measure root respiration is that the 
respiration rate of roots in situ (i.e. undisturbed in the soil) may be different from that of severed roots 
retrieved from soil cores. If this is a problem then root respiration per unit mass should change over time 
since root severing. To assess this, calculate the difference between the time of core extraction and root 
respiration measurement for each core. Plot these values against root respiration per unit time per core, if 
there is no consistent change then it is likely that the values of root respiration derived from this method 
are relatively reliable. 
 
3.5. Equipment Inventory 
 

3.5.1. Rhizotron Equipment 

Fabrication Installation Data collection Data processing  Calibration 

• Wooden planks 
(width~4cm, 
breadth~2cm) 

• anti-termite wood 
varnish 

• perspex sheets 
(length=27cm, 
width=36cm) 

• wood screws 
(length~4cm) 

• Saw 

• electric drill with 
screwdriver 
attachments 

• Flat edged spade 

• Broad hoe/pick axe 

• Hammer 

• Rod (length>30cm, 
diameter~0.5cm) 

 

• A4 transparencies 

• Permanent fine pens 
(black, blue, red, green) 

• Soil moisture sensor 

• digital multimeter 

• battery 

• Soil temperature sensor 

• Note book 

• Scanner 

• WinRHIZO Tron 
software 

• A4 transparencies 

• chisel/plastering 
spatula 

• Flat edged spade 

• drawing pins 

• plastic bags 

• plastic tray 

• sieve (~1mm mesh 
diameter) 

• drying oven 

• weighing balance (0.01 
g resolution) 

3.5.2. Ingrowth core equipment 

Fabrication Installation & 
removal 

Supplementary 
measurements 

Extracting & 
processing roots  

Calibration 

• Plastic mesh 
(diameter~1cm) 

• robust scissors 

• fishing line 

• post-hole digger 
(Portuguese= draga) 

• mesh bags 

• plastic bag 

plastic tray 

• IRGA system (EGM-4 & 
SRC-1) 

• spare battery & EGM-4 
connector 

• Ruler 

• Soil moisture sensor 

• digital multimeter 

• battery 

• watch or timer 

• plastic bags 

• paper bags 

• WinRHIZO 
software 

• Scanner 

• sieve for roots 
(~0.5mm mesh 

• WinRHIZO software 

• Scanner 

• Wire (diameter~0.5, 
1, 2 mm) 

• Ruler 

• Scissors 

• Notebook 
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• Soil temperature sensor 

• plastic bags 

• paper bags 

• Note book 

• sieve for litter (~1mm 
mesh diameter) 

• drying oven 

• weighing balance (0.01 g 
resolution 

diameter) 

• drying oven 

• weighing balance 
(0.01 g resolution 

3.5.3. Standing crop core equipment 

Core extraction Supplementary 
measurements 

Extracting roots  Processing roots 

• post-hole digger 
(Portuguese = draga) 

• plastic bag 

• plastic tray 

 

• IRGA system (EGM-4 & 
SRC-1) 

• spare battery & EGM-4 
connector 

• Ruler 

• Soil moisture sensor 

• digital multimeter 

• battery 

• Soil temperature sensor 

• plastic bags 

• paper bags 

• Note book 

• sieve for litter (~1mm mesh 
diameter) 

• drying oven 

• weighing balance (0.01 g 
resolution 

• watch or timer 

• plastic bags 

 

• IRGA system (EGM-4 & 
SRC-1) 

• Spare battery & EGM-4 
connector 

• Sealed chamber (modified 
collar) 

• Notebook 

• sieve for roots (~0.5mm 
mesh diameter) 

• paper bags 

• drying oven 

• weighing balance (0.01 g 
resolution 
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3.6. Datasheets 

 

3.6.1. RHIZOTRON DATASHEET 

Plot identity:                                                              Data collector: 

 

Session 

Number 

Date 

(dd/mm/yy) 

Soil 

Moisture 

Soil 

Temperature 

Session 

Number 

Date 

(dd/mm/yy) 

Soil 

Moisture 

Soil 

Temperature 
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3.6.2. INGROWTH SOIL CORE DATASHEET 

Date:                                                           Plot Identity: 

 

Core identity Time Collar height Respiration 

with litter 

Respiration 

without litter 

Soil 
moisture 

Soil 
temperature 
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3.6.3. STANDING CROP SOIL CORE DATASHEET 

Date:                                                                Plot identity: 

 

Core 

Identity 

Collar 

height 

Respiration 

with litter 

Respiration 

without 
litter 

Soil 

moisture 

Soil 

temperature 

Core 
extraction 
time 

Root 0-10 
respiration 
time 

Root 0-10 

respiration 
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5. Appendix 

 
5.1. Images 

 

 

Image 1) Installed rhizotron showing foam and black plastic sheet used to minimise temperature variation 
and light/water entry at the perspex face. The entire rhizotron is shielded by a larger black plastic cover.  

 

 

Image 2) Same as above, except with insulation foam sheet removed. Note the roots at the perspex face. 
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Image 3) Note different diameter classes, indicated by line colour, and segments indicating root growth 
over one session, separated by crossbars. No roots have yet disappeared so the all the segments are marked 
just by the session number when they appeared followed by a slash. Example of completed notation = 1/5 
= appeared by session 2 and disappeared by session 5.  

surface of soil 

10cm soil 
depth 

20cm soil 
depth 

transparency ID 

(plot/rhizotron no.) 
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Image 4) The field set-up of the EGM-4 and SRC-1 soil respiration system. Note the pre-installed collar 
used to seal the SRC-1 chamber to the soil.  
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5.2. Rhizotron construction plan 
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5.3. EGM-4 and SRC-1 soil respiration measurement protocol 
 
Data collection: 
1) Connect rubber tubes to ‘gas in’ and ‘gas out’. Connect chamber cable to I/O port. 
2) Switch on (switch at back).  
3) Press: 1: REC. 
4) Press: 1: ALL. 
5) Press: 1: LINEAR. 
6) Chamber volume menu- press: Y/R. 
7) Measurement settings menu- press: Y/R. 
8) Enter new plot number, press: Y/R. 
9) Hold chamber away from body. 
10) When flushing finishes place chamber on soil, press: Y/R. 
11) END, press: Y/R. 
12) RECORD?, press: Y/R. 
13) Remove from soil, press: Y/R. 
14) Take soil temperature and moisture measurements (not less than 20cm from the respiration collar). 
 
Problems: 
1) I pressed something by mistake. 

a) Press N to go back.  
2) EGM-4 displays CHECKSUM ERROR or NONLINEAR FLUX 

a) No problem. Don’t worry. 
3) Something went wrong when I was measuring the flux. 

a) When it says RECORD?, press N and do the measurement again. 
 
Data transfer: 
1 EGM-4 
1) Connect transfer cable to RS232 port on EGM-4 and to computer. 
2) Switch on (switch at back).  
3) Press: 4-DMP. 
4) Press: 2-DATA DUMP. 
2 COMPUTER 
1) Enter PP Systems transfer software. 
2) Press: File > Preferences > Instrument Type > EGM-4. 
3) Press: Transfer > Start. 
4) Save file, file name = cax_date_plot_point numbers_observer (e.g.: cax_22.11.04_PA_1-25_paulo). 
5) Press: Y/N on the EGM-4 
6) Wait for transfer to complete. 
7) Exit software. 
8) Enter Excel, open datafile in excel and save file with the same name as above. 
 
Problems: 
1) It is not transferring? 

a) Try transferring a few more times. 
b) Check the transfer cable connection. 
c) Try other Com Ports (File > Preferences > Com Port). 


